Mailing

Planning a mail merge

LU Ul

The Mail merge helps you to send a number of copies of a document to recipients whose names are
stored in a data file.

Two files are used in this procedure:

- ,ﬁ}lren.ain document containing the permanent text and the fields which act as links to the data source
- A data source file containing the variable information.

A data source file comprises fields and records. For example:

First name Surname Address Post code City
Michael GEHRY 523 Pine St 98144 SEATTLE
Douglas SMITH 55 122nd St 98144 SEATTLE

Each line of information, concerning GEHRY or SMITH, is a record.

Each type of information (First name, Surname...) is a field.

Create the main document.

Link the data file to the main document.

Insert the fields from the data file at the appropriate places in the main document.
Start the mail merge.

Creating a mail merge
Defining the main document

]

To use a new document as the main document, use the shortcut key <] N.

To use a predefined template as the main document, click the File tab, then click New. Click the Sample
Templates button then double click the Merge Letter template to use.

To use a one of your custom templates, click the My templates button and double-click the template
you want to use.

If you want to use an existing document, open that document. It can be an ordinary document or a main
document created during a previous mail merge.

Click the Mailings tab.

Go to the Start Mail Merge group and click the button of the same name. Click either Letters or E-Mail
Messages, according to the type of main document you are using.

With the E-Mail Messages option, you can send custom e-mails to recipients in your address list. To use
this function, Outlook 2010 must be installed on your PC.

Linking a data file to the main document

=]

In the Mailings tab, go to the Start Mail Merge group, press the Select Recipients button and select one
of the following options:

Type New List...: to enter the contents of a new recipients list (cf. Creating a list of data in this
chapter).
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New Address List [~ B[]
Type redpient information in the table. To add more entries, dick Mew Entry.
Title w | First Name w | Last MName w | Company Mame w |.ﬂ.|:.|dress Line 1 = |
]
] m r
| NewEntry | | Find. .. |
[ Delete Entry ] [ Customize Columns... ] (04 ] [ Cancel

Use Existing List...: opens the Select Data Source dialogue box from which you can select a file or
database containing the list of recipients. If the selected list is not what you were looking for, simply
select a different list by clicking the same option again.

If your selected list of data is an Excel workbook (.xls) or an Access database (.accdb), Word opens a
dialogue box when it opens the file so you can choose which worksheet or which table in the database
you want to use for the mailing.

I

Select Table [~ B[]
Mame Description  Modified Created Type
Sheet1$ 8§/3/2010 9:38:03 AM  B/3/2010 9:35:03 AM  TABLE
Sheet2§ 8/3/2010 9:38:03 AM  B/3/2010 9:35:03 AM  TABLE
Sheet3s 8/3/2010 9:38:03 AM  B/3/2010 9:33:03 AM  TABLE

L]

L

First row of data contains column headers

Ok ] [ Cancel

Select from Outlook Contacts...: opens the Select Contacts dialogue box, from which you can select
the list of recipients from your Outlook contacts folder.
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Mail Merge Recipients

R =

This is the list of recipients that will be used in your merge. Use the options below to add to or change your list. Use the
checkboxes to add or remove recipients fram the merge. When your list is ready, dick OK.

Data Source [v Last | First « | Title + | Comparmy + | Address - |City =
Contacts Editions Eni

Contacts [¥  Smith John Editions Eni

Contacts v 3
Contacts ¥  Smile Pennie MyRidesBook.com

Contacts ¥ Bergman Kerry myridesbook.com B
Contacts [¥ Rose Jack myridesbook.com

Contacts [¥ Ribeiro Caroline MyRidesBook

Contacts ¥  Waite Jerry Editions Eni i
P —_ .. - ce e o —
Data Source Refine redpient list

Contacts a| %] sort..

& Filter...

3 Find duplicates. ..

:l,‘ Validate addresses. ..

As a list of data is now linked to the main document, most options in the Mailings tab are now available.

@ If you only want one list of data to be associated with the main document, go to the Mailings tab, click
the Start Mail Merge button (from the group of the same name), then click Normal Word Document.
This action will result in the other options in the list being greyed-out since the document is no longer a
main document, but rather a normal Word document.

Adding mail merge fields to the main document

name).

Enter the contents of the main document (fixed text).
Make sure that the Mailings tab is active.
Place the cursor where the contents of the first field should be printed (for example, the recipient’s

Then click the name of the field to insert.

To insert a field, open the list linked to the Insert Merge Field button (Write & Insert Fields group).

Wid9- 0= Document3 - Microsoft Word o B =
Home Insert Page Layout References Mailings Review  View Developer o @
— N — = - - Rules ~ ol M 41 FoM =
=8 0L @B @ 5 B ELE < &
9% Mateh Fields £7Find Recipient
Envelopes labels  StartMail  Select Highlight ~ Address Greetmgllnsert Merge\ Preview | Finish &
Merge = REclplEnts'REclplEntLlst Merge Fields Block  Line EL Results S Auto Check far Errars | perge -
Create Start Mail Merge Write & I First Name Preview Results Finish
OO SO R 2: 13 4 B 191 10 fic v 12+ 1 43 1 34 (+45 1 16 1 17 | AJBe R8¢ =
[v] [ A1 . 4 Last_Name [ RS IS VS I - DS NS TN NS AN -] ] |
- Address b |
City
- Zip_Code

«First_Name» «Last_Name»T
«Address»T

«City»q

F

«AddressBlock»T

«GreetingLines{

On the Insert tab, the galleries include items that are designed to coordinate with the
overall ook of your document. - You can use these galleries to insert tables, headers, footers,
lists, cover pages, and other document building blocks. -When you create pictures, charts, or

diagrams, they also coordinate with your current document Jook

The Zip Code field is going to be added at the cursor, under the City field. Each added field is enclosed
in merge field characters & % to distinguish it from text.
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<1 To add the Address Block field (combination of several addresses from your recipient list), go to the
Write & Insert Fields group and click the Address Block button.
Under Specify address elements, define the contents of the address block.

-

7S]

Insert Address Block

Specify address elements Preview

Insert redpient's name in this format: Here is a preview from your redpient list:
Josh - 1 B [

Josh Randall Ir. |
Josh Q. Randall Ir. Pennie Reid

Joshua .
JoshuaRandallr. Senengton Gore
Joshua Q. Randall Jr. & ondan

Insert company name

Insert postal address:
Mever indude the countryjreqion in the address

Always indude the countryfregion in the address

_ ) Correct Problems
@) Only indude the country/fregion if different than:
Ifitems in your address block are missing or out of order, use

United States Match Fields to identify the correct address elements from your
mailing list.

Vil t add ding to the destinati tr i
ormat address according e destination countryfregion Match Fields...

[ oK ]’ Cancel ]

If some items do not have an address, click the Match Fields... button to identify the correct address
elements from your contact list.
Click OK.

The «AddressBlock> field appears at the cursor.
=] To add a Greeting Line, go to the Write & Insert Fields group and click the Greeting Line button.
To define the contents of this field, use the lists under Greeting line format area.

’Insert Greeting Line @ﬁ

Greeting line format:

Dear [v] EETE -] [ []
Greeting line for invalid redpient names:

Dear Sir or Madam, |E|

Prewview

Here is a preview fram your recipient list:

L [ [

Dear Peninie,

Correct Problems
If items in your greeting line are missing or out of order, use Match Fields to

identify the correct address elements from your mailing list.
Match Fields. ..

[ Ok ][ Cancel ]

If items in your greeting line are missing or out of order, use Match Fields... to identify the correct
address elements from your contacts list.
Click OK.

é} To highlight the fields you have added to your document, go to the Mailings tab, Write & Insert Fields
group and click the Highlight Merge Fields button.
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Checking the mail merge

It is useful to preview a mail merge in case you want to make any changes before proceeding with it.
Make sure the Mailings tab is active.

To display a preview of the mail merge results, go to the Preview Results group and click the Preview
Results button.

In the main document, you see a preview of the letter corresponding to the data list entries.
Use the following buttons, from the Preview Results group, to display a preview of the other entries:

first record — + last record
H 4|1 bW
previous record 1 T_ next record

You can also enter the record number in the relevant field and press the =1 key.

To see fields in the main document again, click the Preview Results button to deactivate it.

To check for errors that might occur during the merge, go to the Preview Results group and click the
Check for Errors button.

Choose one of the three options from the Checking and Reporting Errors dialogue box, then click OK.

@ While previewing, you can Find Recipient from the recipient list by clicking the button of the same name

in the Preview Results group (cf. Mailing - Managing the records in a data list).

Completing the mail merge

]

In the Mailings tab, go to the Finish group, click the Finish & Merge button and choose one of the fol-
lowing options:

Edit Individual Documents...: the merge takes place in a new document, with a page break inserted
between each letter.

Print Documents...: the merge is sent to the printer.

Send E-mail Messages...: the merge allows you to send the document to recipients by e-mail.

Specify which records should be merged:

To merge all the records selected in the data list, select All.

To merge the Current record, select the option with the same name.

To restrict the merge to a number of elements selected in the data list, specify the number of the first
record in the From list, and the last record in the To list.

If it is an e-mail message merge, fill in the Message options.

-

Merge to E-mail @
Message options
Ta: Email_Address IZI
Subject line: |pocumentation
Mail format: | L IZI
Send records
All
Current record
@ From: |5 To: |15
[ oK ] | Cancel
To Select the field against which the email addresses are stored.
Subject line Select the message subject.
Mail format Select either Plain Text or HTML to send the main document in the message body;

select Attachment to send the document as an attachment.

Unlike the HTML option, the Plain Text option does not permit formatting or graphics in messages.
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<1 Click OK from the Merge dialogue box.
+1 If the merge was completed in a new document, you can either save or print it, then close it.
=] Save the main document then close it.

When you save the main document, you also save the link to the data list.

If changes have been made to the data list, Word prompts you to save them. In this case, click Yes to
save the changes made to the main document.

@ If you click the Edit Recipients List... button (Start Mail Merge group), the Mail Merge Recipients
dialogue box opens, from which you can edit the contents or look of the data list.

To create a data list using the Mail Merge Wizard, go to the Start Mail Merge group (Mailing tabs), click
the button of the same name, then follow the steps in the wizard to create your data list; you will find
the same options as those explained above.

Opening a main document
=] Click the File tab then Open.

<1 Select the folder where the main document is stored then double-click the file to open it.

Word detects whether a data file is linked to the document you want to open, and prompts you to add
the file data to the main document.

Microsoft Word @

Opening this document will run the following 5QL command:

=

! _ SELECT ®FROM "Sheet15

Data from your database will be placed in the document. Do you want to continue?

| Show Help = |

The Show Help button displays the message text.
<1 Click one of the following buttons:
Yes to establish the link between the main document and data file.
No to delete the link between the main document and the data file. The main document then
becomes a normal word document.

If you choose to establish the link between this document and the data file, the options under the
Mailings tab become available. These options are greyed out (i.e. not available) if you choose to delete
the link.

Creating a list of data

=] If the main document already exists, open it. Otherwise, create a new document in which you enter the
fixed text for the mailing.

<1 Make sure the main document is open in Word.

=1 In the Mailings tab, go to the Start Mail Merge group, click the Select Recipients button, then Type New
List....

The New Address List dialogue box appears displaying a list of predefined fields.





